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Kami menerima jasa pembuatan program 
berbasis arduino untuk berbagai keperluan. 
Untuk informasi lebih lanjut, silakan klik 
http://hire.elangsakti.com/ dan isi form 
penawaran yang kami sediakan. 
Lebih cepat lebih baik. J 
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Catatan Pembuka 

 
Ebook ini terinspirasi dari buku Introduction to Arduino karangan 

Alan G. Smith. Oleh sebab itu, sebagian isi dari ebook ini mengikuti 

alur pembahasan dari buku tersebut, tapi dengan berbagai improvisasi 

baik dari segi rangkaian dan program. Gambar rangkaian pada ebook ini 

dibuat dengan aplikasi Fritzing.org dan SnagIt. Arduino yang digunakan 

dalam ebook ini adalah Arduino Uno. 
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Untukmu 

Generasi Muda Indonesia 

 

Sebelumnya, saya bersyukur kepada Allah SWT yang telah 

memelihara otak dan tubuh ini, menjaga dan membuatnya mudah dalam 

mempelajari sebagian ciptaannya. Bersyukur karena masih diberikan 

kesempatan untuk berbagi tentang apa yang penulis bisa, untuk negeri 

ini, untuk kalian semua. 

Ebook ini dipersembahkan untuk generasi muda Indonesia. 

Generasi yang akan mewarnai Indonesia 3ï10 tahun mendatang dengan 

teknologi dan karya terbaik mereka. Karena salah satu faktor kemajuan 

suatu negeri ditentukan dengan teknologi yang berkembang di 

masyarakat negeri tersebut. 

Ebook ini dipersembahkan untuk para pendidik, siswa, dan 

mahasiswa yang berkecimpung dalam elektronika dan komputer. 

Sehingga mereka bisa membuat prototype dari teknologi impian yang 

ingin mereka buat. Diharapkan akan muncul ide-ide brilian sebagai 

solusi dari masalah-masalah kehidupan sehari-hari yang kita alami. 

Ebook ini ditujukan bagi mereka yang ingin mulai belajar tentang 

robotika, membuat mesin-mesin otomatis, dan yang ingin mendalami 

Internet of Things (IoT). Arduino bisa dikembangkan dan dipadukan 

dengan berbagai sensor dan kecerdasan buatan, mengintegrasikan 

dengan website, dan banyak hal lainnya yang memungkinkan untuk 

membuat rumah cerdas (smart house), smart gardening, smart farming, 

hingga smart city. 
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Bagian 1 

Pengenalan Arduino 
 

Ebook ini dimaksudkan agar Anda yang masih pemula dalam 
dunia mikrokontroller dapat mengikuti dan mempelajari Arduino 
dengan mudah dan segera mempraktekkannya. Oleh sabab itu, kami 
akan membahas tentang konsep elektronik, sensor, dan bahasa 
pemrograman secukupnya dengan harapan Anda bisa segera praktek 
tanpa memikirkan konsep elektronika yang relatif rumit. 

Dalam setiap bahasan, kami Akan menyajikan konsep singkat dari 
apa yang sedang dibahas dalam bahasan tersebut. Misal, ketika kita 
membahas tentang rangkaian sensor suhu, maka akan dibahas pula 
tentang komponen sensor suhu, cara kerja, cara merangkai, dan cara 
memprogramnya. Hal tersebut dimaksudkan agar pembaca bisa dengan 
mudah mengikuti dan memahami apa yang kami sajikan serta sedikit 
demi sedikit mempelajari tentang elektronika (mikrokontroller) dan 
bahasa pemrograman. 

 

1.1 Apa itu Mikrokontroller? 
Menurut wikipedia1: 

A microcontroller (sometimes abbreviated µC, uC or MCU) is a small 
computer on a single integrated circuit containing a processor core, 
memory, and programmable input/output peripherals. 

Dalam diskusi sehari-hari dan di forum internet, mikrokontroller 
sering dikenal dengan sebut µC, uC, atau MCU. Terjemahan bebas dari 
pengertian tersebut, bisa dikatakan bahwa mikrokontroller adalah 
komputer yang berukuran mikro dalam satu chip IC (integrated 
circuit) yang terdiri dari processor, memory, dan antarmuka yang bisa 
diprogram. Jadi disebut komputer mikro karena dalam IC atau chip 
mikrokontroller terdiri dari CPU, memory, dan I/O yang bisa kita 
kontrol dengan memprogramnya. I/O juga sering disebut dengan 

                                                             
1 https://en.wikipedia.org/wiki/Microcontroller 
2 https://www.arduino.cc/en/Main/Software 
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GPIO (General Purpose Input Output Pins) yang berarti : pin yang bisa 
kita program sebagai input atau output sesuai kebutuhan. 

 

Gambar 1.1 Board Arduino Uno 

Dalam ebook ini kita akan menggunakan board Arduino Uno 
(Gambar 1.1). Board Arduino terdiri dari hardware / modul 
mikrokontroller yang siap pakai dan software IDE yang digunakan 
untuk memprogram sehingga kita bisa belajar dengan mudah. 
Kelebihan dari Arduino yaitu kita tidak direpotkan dengan rangkaian 
minimum sistem dan programmer karena sudah built in dalam satu 
board. Oleh sebab itu kita bisa fokus ke pengembangan sistem. 

 

Gambar 1.2 Project board dan Kabel Jumper 

Untuk praktek, kita akan menggunakan project board (ada yang 
menyebutnya dengan istilah bread board) dan beberapa kabel jumper 
untuk menghubungkan antara komponen dan Arduino (Gambar 1.2). 
Dengan project board kita tidak perlu menyolder rangkaian sehingga 
relatif mudah dan cepat dalam merangkai. Project board memungkinkan 
kita untuk membangun dan membongkar rangkaian dengan cepat 
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sehingga sangat cocok untuk eksperimen. Tapi jika kita ingin membuat 
rangkaian yang permanen, maka kita harus menggunakan PCB. 

 

Gambar 1.3 Peta jalur pada project board 

Yang terpenting adalah, kita harus memahami jalur-jalur pada 
project board. Project board terdiri dari jalur vertikal dan jalur horisontal. 
Jalur vertikal ada di bagian tengah yang terdiri dari 2 x 64 jalur. 
Masing-masing jalur terdiri dari 5 titik vertikal, misal jalur 1A-1B-1C-
1D-1E dan jalur 1F-1G-1H-1I-1J yang kedua tidak saling tersambung. 
Jalur horisontal sebanyak 8 jalur, 4 jalur ada di bagian atas dan 4 jalur 
lagi di bagian bawah. Jalur ini bisa digunakan untuk power supply 
(VCC dan GND) untuk rangkaian. Untuk lebih jelasnya, silakan 
perhatikan Gambar 1.3. Garis merah menunjukkan bahwa lubang 
tersebut terhubung secara fisik. 

 

1.2 Instalasi Arduino IDE 
Anda bisa mendownload Arduino IDE di website Arduino2. Pada 

saat tulisan ini dibuat (30/06/2015), Arduino IDE sudah versi 1.6.5. 
Software Arduino ada yang versi installer (hanya untuk Windows) dan 
versi terkompres dalam zip. Jika memilih versi tanpa install (format 
.zip), maka Anda hanya perlu mengekstraknya di folder mana saja dan 
Anda bisa langsung menjalankannya. 

Jika Anda pengguna Linux, maka sedikit tantangan untuk Anda 
karena proses instalasi tidak semudah instalasi di Windows dan Mac. 
Panduan untuk menginstall di Linux bisa Anda pelajari di bagian 

                                                             
2 https://www.arduino.cc/en/Main/Software 
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instalasi Linux3. Sedangkan untuk pengguna Windows dan Mac, Anda 
bisa menginstall dengan mengikuti instruksi dalam ebook ini. 

 

1.2.1 Instalasi di Windows 
1. Pasang board Arduino Anda ke port USB pada komputer atau 

laptop, kemudian tunggu hingga Windows mencoba untuk 
menginstall driver sendiri. Biasanya dia gagal menginstall 
driver jika belum memiliki driver tersebut. (Silakan lanjutkan ke 
step berikutnya) 

2. Jika berhasil, berarti instalasi selesai. Tapi jika gagal, lanjutkan 
ke step selanjutnya. 

3. Anda harus install dari device manager. Untuk masuk ke device 
manager, Anda bisa melakukannya dengan dua cara: 

 
Gambar 1.4 Posisi tombol Windows 

ü Tekan tombol ("Windows" + R) secara bersamaan. 
Tombol "Windows" adalah tombol pada keyboard dengan 
logo Windows (gambar logo windows, biasanya terletak di 
sebelah kiri atau kanan spasi, lihat Gambar 1.4). Setelah 
Anda menekan tombol "Windows" + R, maka akan muncul 
"Run", ketikkan "devmgmt.msc" (tanpa tanda petik), 
kemudian tekan tombol ENTER. Jika benar, maka akan 
muncul window Device Manager. 

                                                             
3 http://playground.arduino.cc/Learning/Linux 
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Gambar 1.5 Window yang muncul setelah menekan (Windows + R) 

ü Jika Device Manager Anda sudah keluar, Anda bisa lanjut ke 
point 4, jika tidak, coba cara berikut untuk menampilkan 
device manager 

ü Klik Start - pilih Control Panel. Di dalam Control Panel, 
pilih System and Security, lalu pilih System. Selanjutnya pilih 
Device Manager. 

 

Gambar 1.6 Tampilan Device Manager 

4. Pada Device Manager, perhatikan bagian Ports (COM & LPT), 
akan muncul device baru dengan nama "Arduino UNO 
(COMxx)" 

5. Klik kanan pada "Arduino UNO (COMxx)", kemudian pilih 
"Update Driver Software". 

6. Selanjutnya pilih "Browse my computer for Driver software". 
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7. Cara folder software Arduino Anda, kemudian cari file 
arduino.inf (khusus untuk Arduino UNO REF.3) pada folder 
Drivers. Jika Anda menggunakan versi IDE di bawah 1.0.3, 
Anda bisa memilih driver dengan nama file ArduinoUNO.inf 

8. Jika berhasil, berarti instalasi driver sudah selesai. Jika belum, 
silakan Anda tanya-tanya di web http://www.elangsakti.com  

9. Selanjut mari kita coba untuk mengupload sampel code yang 
ada pada software Arduino 

10. Jalankan Aplikasi Arduino (arduino.exe), pada pojok kanan 
bawah akan ada tulisan "Arduino UNO on COMxx". Berarti 
port yang digunakan Arduino adalah COMxx, jika tulisan 
tersebut tidak muncul, berarti instalasi driver belum berhasil 
atau board Arduino belum disambungkan ke komputer. 
Selanjutnya, silakan buka sampel led flip-flop dengan cara Klik 
menu File > Examples > 1.Basic > Blink 

11. Setting board Arduino dengan cara : Klik menu Tools > Board 
> Arduino UNO 

12. Pilih port yang digunakan Arduino dengan cara mengklik 
menu Tools > Ports > (pilih yang ada Arduino-nya) 

13. Klik tombol upload (tombol denga panah ke kanan) 
14. Setelah berhasil diupload, akan muncul tulisan "Done 

uploading" di bagian bawah. Jika berhasil, maka LED dengan 
tulisan "L" pada board Arduino akan kelap-kelip. 
 

1.2.2 Instalasi pada Mac 
1. Pasang board Arduino melalui USB 
2. Ekstrak aplikasi ke hardisk 
3. Ketika muncul Network Preferences, klik "Apply" (ingat 

/dev/tty/usb)  
4. Jalankan aplikasi 
5. Bukan sampel aplikasi pada menu File > Example > 1.Basics > 

Blink 
6. Pilih Arduino Uno pada menu Tools > Board 
7. Pilih Port yang yang digunakan Arduino pada menu Tools > 

Ports 
8. Klik tombol upload (tombol dengan panah ke kanan) 
9. Setelah muncul pesan "Done Uploading", maka led "L" pada 

board Arduino akan berkedip. 
 

http://www.elangsakti.com/
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1.3 Arduino IDE 
Untuk memprogram board Arduino, kita butuh aplikasi IDE 

(Integrated Development Environment) bawaan dari Arduino. Aplikasi ini 
berguna untuk membuat, membuka, dan mengedit source code Arduino 
(Sketches, para programmer menyebut source code arduino dengan istilah 
"sketches"). Selanjutnya, jika kita menyebut source code yang ditulis 
untuk Arduino, kita sebut "sketch" juga ya :). Sketch merupakan source 
code yang berisi logika dan algoritma yang akan diupload ke dalam IC 
mikrokontroller (Arduino). 

 
Gambar 1.7 Interface Arduino IDE 

Interface Arduino IDE tampak seperti gambar 1.7. Dari kiri ke 
kanan dan atas ke bawah, bagian-bagian IDE Arduino terdiri dari: 

V Verify  : pada versi sebelumnya dikenal dengan istilah Compile. 
Sebelum aplikasi diupload ke board Arduino, biasakan untuk 
memverifikasi terlebih dahulu sketch yang dibuat. Jika ada 
kesalahan pada sketch, nanti akan muncul error. Proses Verify / 
Compile mengubah sketch ke binary code untuk diupload ke 
mikrokontroller. 



8 

V Upload : tombol ini berfungsi untuk mengupload sketch ke 
board Arduino. Walaupun kita tidak mengklik tombol verify, 
maka sketch akan di-compile, kemudian langsung diupload ke 
board. Berbeda dengan tombol verify yang hanya berfungsi 
untuk memverifikasi source code saja. 

V New Sketch : Membuka window dan membuat sketch baru 
V Open Sketch : Membuka sketch yang sudah pernah dibuat. 

Sketch yang dibuat dengan IDE Arduino akan disimpan dengan 
ekstensi file .ino 

V Save Sketch : menyimpan sketch, tapi tidak disertai 
mengcompile. 

V Serial Monitor  : Membuka interface untuk komunikasi serial, 
nanti akan kita diskusikan lebih lanjut pada bagian selanjutnya 

V Keterangan Aplikasi : pesan-pesan yang dilakukan aplikasi 
akan muncul di sini, misal "Compiling" dan "Done Uploading" 
ketika kita mengcompile dan mengupload sketch ke board 
Arduino 

V Konsol : Pesan-pesan yang dikerjakan aplikasi dan pesan-pesan 
tentang sketch akan muncul pada bagian ini. Misal, ketika 
aplikasi mengcompile atau ketika ada kesalahan pada sketch 
yang kita buat, maka informasi error dan baris akan 
diinformasikan di bagian ini. 

V Baris Sketch : bagian ini akan menunjukkan posisi baris 
kursor yang sedang aktif pada sketch. 

V Informasi Port  : bagian ini menginformasikan port yang 
dipakah oleh board Arduino. 

 

1.4 Rangkaian LED Pertama 
Ketika belajar pemrogaman, program pertama yang harus dicoba 

pertama kali adalah memunculkan pesan "Hello World!". Dalam 
belalajar mikrokontroller ternyata juga ada, yang pertama kali harus 
dibuat adalah membuat lampu LED berkedip, LED berkedip 
maksudnya adalah flip-flop, hehe. J 

LED merupakan kependekan dari Light Emiting Diode, yaitu diode 
yang mampu mengubah listrik menjadi cahaya. Sebagaimana sifat 
diode, lampu LED memiliki kaki positif dan negatif. Sehingga 
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pemasangannya tidak boleh terbaik, jika dipasang terbalik maka tidak 
akan ada arus yang mengalir dan LED pun tidak akan menyala. 

Arduino bekerja pada tegangan 5-12 volt dengan arus yang relatif 
besar yang sanggup memutuskan LED. Sehingga jika kita ingin 
menyambungkan LED, maka kita butuh tahanan (resistor) untuk 
membatasi arus yang masuk ke LED. LED memiliki tegangan kerja 
yang disebut dengan forward voltage (fv) yang mana tegangan ini 
adalah tegangan yang dibutuhkan LED untuk bisa menyala dengan 
baik. 

Ukuran resistor yang bisa dipakai adalah 100ɋ hingga 1Kɋ (ɋ 
dibaca ohm, satuan dari resistansi/hambatan), makin besar nilai 
resistor maka nyala LED akan semakin redup. Pada Arduino, tegangan 
yang keluar dari pin-pinnya adalah 0-5 volt. Sementara catu daya 
untuk Arduino antara 5-12 volt. Oleh sebab itu, pemilihan resistor 
tergantung tegangan mana yang akan kita gunakan. 

 

Rangkaian 1.1 Percobaan LED 

Silakan buatlah Rangkaian 1.1 dengan langkah-langkah sebagai 
berikut: 

1. Pasang kaki positif LED di G4 dan kaki negatifnya di G3, 
2. Setelah itu, hubungkan salah satu kaki resistor pada lubang J3, 

kemudian kaki satunya ke lubang di kolom pertama dari 
kanan, 

3. Ambil kabel jumper, lalu sambungkan lubang J4 ke lubang di 
kolom kedua dari kanan, 

4. Ambil kabel jumper, sambungkan salah satu lubang di kolom 
pertama ke socket GND pada board Arduino, 
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5. Ambil kabel jumper, sambungkan salah satu lubang di kolom 
kedua ke socket 5V di board Arduino 

6. Hubungkan USB Arduino ke komputer/laptop. 
7. Selamat! Anda sudah membuat rangkaian pertama Anda 

dengan Arduino. J 

Jika Anda memasangnya dengan benar, maka LED akan menyala. 
Jika tidak, mungkin kaki dipasang terbalik, silakan diperbaiki. 

 

1.6 Program Pertama Anda 
Program pertama Anda adalah membuat kedipan LED. Untuk itu, 

yang pertama harus Anda lakukan adalah mengubah Rangkaian 1.1, 
setelah itu Anda bisa membuat program pada Arduino IDE. Logika 
untuk program pertama seperti berikut: 

 Kedipan LED (hidup-matinya LED) akan dikontrol oleh salah satu 
kaki Arduino (kita pilih kaki/pin 8). Dengan demikian, logika pada 
pin 8 akan menjadi output  untuk mengontrol LED. Ingat, logika 1 
berararti LED akan nyala, logika 0 berarti LED mati. 

 

1.6.1 Update Rangkaian Anda 
Rubahlah rangkaian Anda sehingga tampak seperti Rangkaian 1.2. 

Kabel jumper dari 5V ke kolom pertama dilepas. Kemudian kabel di 
kolom kedua dilepas dan disambungkan ke pin 8 pada board Arduino. 

 

Rangkaian 1.2 Rangkaian LED Berkedip 
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1.6.2 Program untuk LED Berkedip 

Ketika Anda pertama kali membuka Arduino IDE, maka secara 
otomatis akan muncul sketch seperti berikut: 

Sketch 1.1 Sketch minimal Arduino 

1 

2 
3 

4 

5 
6 

7 
8 

9 

void  setup() {  

  // put your setup code here, to run once:  
 

}  

 
void  loop() {  

  // put your main code here, to run repeatedly:  
 

}  

 

Fungsi setup() dan fungsi loop() merupakan fungsi wajib dan harus 
ada. Fungsi setup() digunakan untuk inisialisasi program, fungsi ini 
hanya dijalankan sekali yaitu ketika program pertama kali dijalankan 
(ketika arduino pertama kali dihidupkan). Sedangkan fungsi loop() akan 
dijalankan terus-menerus (looping forever) hingga Arduino dimatikan. 

Program di atas sudah bisa diupload ke Arduino dengan cara 
meng-klik tombol Upload. Hanya saja, ketika program tersebut 
diupload, Arduino tidak akan melakukan apa-apa sebab dalam sketch 
tersebut memang tidak ada perintah yang harus dikerjakan. 

Dalam ebook ini, jika ada sketch yang harus Anda coba, maka kami 
akan menampilkan sketch terlebih dahulu, setelah itu akan kami jelaskan 
fungsi dan logika dari sketch tersebut. Untuk mengawali primordial 
dalam belajar mikrokontroller, maka Anda harus mencoba sketch ini. 
Berikut ini adalah sketch untuk membuat kedipan LED. 

Sketch 1.2 LED Berkedip :p 

1 

2 
3 

4 
5 

6 

7 
8 

9 

10  

// Free Ebook  Arduino  

// www.elangsakti.com   
// coder elangsakti  

 
const int  pinLED = 8;  

 

void  setup() {  
    pinMode(p inLED, OUTPUT);  

}  

 

http://www.elangsakti.com/
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11  

12  
13  

14  
15  

16  

void  loop() {  

    digitalWrite(pinLED, HIGH);  
    delay(500);  

    digitalWrite(pinLED, LOW);  
    delay(500);  

}  

 
Baik, mari kita ulas satu-persatu baris-baris sketch 1.2. 

5 const int  pinLED = 8;  

 
Nama-nama pin pada Arduino sama seperti yang tertera di board. 

Pada salah satu sisi board, nama-nama pinnya adalah 0 hingga 13, 
kemudian di sisi lain nama-nama pinnya A0 hingga A5, dst. Perintah 
pada baris 5 artinya : Variabel pinLED merupakan konstanta dalam 
bentuk integer yang merujuk pada pin 8 board Arduino. 

Tolong diingat baik-baik, untuk kemudahan dalam memprogram, 
sebaiknya inisialisasi pin-pin dijadikan konstanta dan ditentukan di 
awal program. Sehingga, misal ketika kita ingin mengubah pin yang 
akan dirujuk, kita tidak akan kesusahan. Kita tinggal mengubah nilai 
dari variabel pin tersebut, maka kita tidak perlu langi mengubah 
variabel lainnya. 

7 

8 
9 

void  setup() {  

    pinMode(pinLED, OUTPUT);  
}  

 
Fungsi pinMode() memberi tahu bahwa pinLED adalah Output. 

Dengan demikian mikrokontroller tidak akan òmembacaó logika pin 
tersebut, akan tetapi dia hanya akan òmenulisó logika pada pin tersebut. 
Dengan kata lain, jika kita ingin mendefinisikan bahwa pin ini adalah 
input, maka kita tinggal mengubah OUTPUT  menjadi INPUT . 

11  
12  

13  

14  
15  

16  

void  loop( ) {  
    digitalWrite(pinLED, HIGH);  

    delay(500);  

    digitalWrite(pinLED, LOW);  
    delay(500);  

}  
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Baris ini adalah inti dari program yang akan dieksekusi selama 
Arduino tersambung dengan listrik atau selama Arduino tidak direset. 
pinLED diset HIGH berarti LED akan diberi tegangan 5 volt, 
sedangkan LOW berarti LED akan diberi tegangan 0 volt. Oleh sebab 
itu, rangkaian LED di atas akan menyala ketika diberi HIGH dan akan 
mati ketika diberi LOW. 

Fungsi delay() digunakan untuk berhenti selama sekian milidetik. 
Karena 1 detik = 1000 milidetik, maka pemberian nilai 500 berarti 
Arduino akan jeda selama ½ detik ketika LED nyala dan ½ detik ketika 
LED padam. Lalu bagaimana jika program yang Anda coba tidak 
berjalan dan error? Begini, ada beberapa yang perlu diperhatikan ketika 
Anda memprogram: 

1. Penulisan sketch itu case sensitive, artinya,  tulisan òpinLEDó 
tidak sama dengan òPinLEDó. Jika terjadi error, coba 
perhatikan apakah ada penulisan yang keliru? 

2. Jika Anda copy-paste sketch dari file PDF ke Arduino IDE, maka 
kemungkinan akan ada perubahan whitespace (spasi, tab, blank 
line). Jika spasi tergantikan denan karakter tab atau blank line, 
maka sketch akan error. Silakan Anda cek setiap spasi, jika 
ukuran space-nya berbeda dengan spasi yang lain, silakan 
dihapus dan ganti dengan spasi. 

3. Setiap blok kode harus diapit dengan kurung kurawal ô{õ dan 
ô}õ. Jika kurungnya kurang satu, maka akan error. 

4. Setiap ada kurung buka ô(õ, harus ada kurung tutup ô)õ. Jadi jika 
ternyata kurungnya kurang, itu bisa menyebabkan error. 

5. Penulisan angka tanpa embel-embel koma. Misal Anda ingin 
menulis 1000, maka tidak perlu menulis dengan 1,000 atau 
1.000. Penulisan dengan 1,000 akan terjadi error, sedangkan 
jika Anda menulis dengan 1.000 akan dianggap 1, bukan 1000. 

6. Setiap baris kode akan ditutup dengan titik koma (semicolon) ô;õ, 
kecuali di akhir blokkode yang ditutup dengan kurung 
kurawal ô}õ. 

 

1.5 Menambah Keterangan pada Sketch 
Dalam membuat kode program, kita kadang butuh untuk 

menyisipkan keterangan tambahan pada fungsi kode tersebut. Misal, 
keterangan fungsi, keterangan pin, atau keterangan lainnya. 
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Pada Arduino, komentar bisa kita sisipkan dengan dua cara: 

1. Menggunakan double slash ò//ó, cara ini hanya bisa digunakan 
perbaris. Jadi jika banyak baris yang ingin kita jadikan 
komentar, Anda bisa menggunakan cara yang kedua. Contoh: 

1 
2 

3 

// ini komentar  
// ini komentar lagi  

// ini juga komentar  

 
2. Menggunakan pembuka ò/*ó dan penutup ò*/ó 

1 

2 

3 
4 

5 

/*  ini komentar  

    ini masil komentar  

    ini juga komentar  */  
 

/* ini komentar */  

 
Jadi, jika sketch kedipan led tadi kita tambahin keterangan untuk 

setiap baris kodenya, maka setidaknya akan seperti ini. 

Sketch 1.3 Contoh Sketch dengan komentar 

1 

2 

3 
4 

5 
6 

7 

8 
9 

10  
11  

12  

13  
14  

15  

16  
17  

18  
19  

20  

21  
22  

23  

// Free Ebook  Arduino  

// www.elangsakti.com   

// coder elangsakti  
 

/*  
 Program untuk membuat LED berkedip  

 ½ detik nyala ½ detik mati  

 */  
 

// inisialisasi pin untuk mengontrol LED, yaitu pin 8  
const int  pinLED = 8;  

 

/*  
 Bagian ini akan dieksekusi sekali ketika Arduino pertama kali  

 Dinyalakan atau ketika Arduino direset  

 */  
void  setup() {  

    //  pin 8 diset sebagai OUTPUT  
    pinMode(pinLED, OUTPUT);  

}  

 
/*  

 Bagian ini akan dieksekusi selama lis trik tersambung  

http://www.elangsakti.com/
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24  

25  
26  

27  
28  

29  

30  
31  

32  

33  
34  

35  

 Atau arduino tidak direset  

 */  
void  loop() {  

    //  nyalakan LED  
    digitalWrite(pinLED, HIGH);  

    // delay 500 milisekon / ½ menit  

    delay(500);  
    // matikan LED  

    digitalWrite(pinLED, LOW);  

    // delay selama 500 milisekon / ½ m enit  
    delay(500);  

}  

 
Demikian untuk pengenalan singkat tentang Arduino, merakit 

komponen dengan peoject board, dan membuat program sederhana 
LED berkedip. Silakan lakukan improvisasi rangkaian tersebut 
sehingga lebih paham dan lebih nyaman menggunakan project board. 
Selanjutnya, kita akan lebih mendalami beberapa perintah dasar dan 
fungsi-fungsi logika untuk membuat program Arduino. 

Salam semangat! J 

 

 

 

 

Kami menerima jasa pembuatan program 
berbasis arduino untuk berbagai keperluan. 
Untuk informasi lebih lanjut, silakan klik 
http://hire.elangsakti.com/ dan isi form 
penawaran yang kami sediakan. 
Lebih cepat lebih baik. J 

 

 

 

 

http://hire.elangsakti.com/
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Pemuda yang tidak bercita -cita bukan 

pemuda, tetapi pemuda yang sudah mati 

sebelum mati.  

(Ir. Soekarno)  
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Bagian 2 

Animasi LED 
 

Sebelumnya kita sudah belajar tentang membuat LED berkedip, 
saat ini kita akan lebih memahami lebih dekat tentang bahasa 
pemrograman dan fungsi-fungsi logika yang umum dipakai. 
Implementasi dari pembelajaran fungsi logika tersebut akan diterapkan 
pada beberapa model Animasi LED seperti running LED atau yang 
lainnya. 

 

2.1 Perintah IF dan IF - ELSE 
Perintah IF memiliki beberapa kombinasi, bisa IF saja, IF-ELSE, 

IF-ELSE IF-ELSE, dan seterusnya. Semakin kompleks tentu logika 
yang dipakai akan tampak semakin òrumitó. J 

 

2.1.1 Perintah IF 
Mari kita modifikasi program Sketch 1.1 menjadi seperti berikut: 

Sketch 2.1 Modifikasi timeDelay 

1 
2 

3 

4 
5 

6 

7 
8 

9 
10  

11  

12  
13  

14  
15  

16  

17  
18  

// Free Ebook  Arduino  
// www.elangsakti.c om   

// coder elangsakti  

 
// Pin 8 untuk LED  

const int  pinLED = 8;  

 
void  setup() {  

    // pin LED sebagai output  
    pinMode(pinLED, OUTPUT);  

}  

 
// awal time delay 1000 | 1 detik  

int  timeDelay = 1000;  
 

void  loop() {  

    // Setiap looping, nilai timeDelay d ikurangi 100  
    timeDelay = timeDelay -  100;  

http://www.elangsakti.com/
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19  

20  
21  

22  
23  

24  

25  
26  

27  

28  
29  

30  
31  

32  

 

    /* Jika timeDelay bernilai 0 atau negatif  
       maka nilai timeDelay direset ke 1000  

     */  
    if (timeDelay <= 0){  

      timeDelay = 1000;  

    }  
     

    //Nyalakan dan matikan LED selama timeDelay  

    digitalWrite(pinLED, HIGH);  
    delay(timeDelay);  

    digitalWrite(pinLED, LOW);  
    delay(timeDelay);  

}  

 
Apakah Anda bisa membayangkan apa yang akan terjadi dengan 

LED tersebut? LED tersebut awalnya akan berkedip pelan, lama-lama 
akan berkedip cepat, dan akan akhirnya akan berkedip pelan lagi. 
Percayakah Anda? Jika tidak, silakan dicoba. J 

Ketika awal dinyalakan, maka timeDelay adalah 1000. Nilai 
tersebut diinisialisasi pada baris 14. Baris ini tidak dijadikan konstanta 
(const) sebagaimana pinLED karena nilai timeDelay akan diubah-ubah. 

14      int  timeDelay = 1000;  

 
Setelah masuk ke bagian utama aplikasi, pada baris 18 nilai 

timeDelay dikurangi 100. 

18      timeDelay = timeDelay -  100;  

 
Sehingga timeDelay pertama yang digunakan untuk menyalakan 

dan mematikan LED adalah 900. Pada perulangan selanjutnya, 
timeDelay kembali dikurangi 100, sehingga perulangan ke dua 
menggunakan timeDelay 800 (lebih singkat dari timeDelay yang awal), 
begitu seterusnya hingga pada timeDelay 100. 

Pada waktu melewati timeDelay 100, ketika dikurangi dengan 100, 
maka timeDelay bernilai 0. Kondisi ini cocok dengan baris ke 23, 

23  
24  

    if (timeDelay <= 0){  
      timeDelay = 1000;  



19 

25      }  

 
Jika (IF) timeDelay lebih kecil atau sama dengan 0, maka timeDelay 

akan diisi dengan 1000. Sehingga nilai timeDelay tidak akan pernah 
negatif dan hal tersebut akan berulang terus-menerus. Hal ini lah yang 
membuat durasi nyala hidup-mati LED bisa berubah lebih cepat. 

Beberapa operator matematika yang dibutuhkan dalam bahasa 
pemrograman yaitu: 

Operator Arti  
= Operator assignment, untuk memberi nilai pada variabel 
+ Operator penambahan 
- Operator pengurangan 
*  Operator perkalian 
/  Operator pembagian. Sebagai catatan: 

- Jika tipe data yang digunakan adalah integer (int), 
maka hasil bagi adalah nilai asli, bukan desimal. Misal 
5/2 = 2, bukan 2.5 atau 3. Tapi jika tipe data yang 
digunakan adalah double/float, maka hasil bagi 
adalah angka desimal. Misal, 5/2 = 2.5 

% Operator modulo (sisa pembagian). Misal: 
- 10%2 = 0, 10 dibagi 2 = 5 + 0 
- 10%3 = 1, 10 dibagi 3 = 3 + 1 
- 10%4 = 2, 10 dibagi 4 = 8 + 2 
- 10%5 = 0, 10 dibagi 5 = 2 + 0 

 
 Perintah IF pasti akan diikuti dengan kondisi yang bernilai True 

yang diapit dengan tanda kurung, if (kondisi). Pada Sketch 2.1 di atas 
kondisi yang digunakan adalah timeDelay <=  0, timeDelay lebih kecil 
atau sama dengan nol. Artinya, jika timeDelay bernilai 0 atau lebih 
kecil dari 0, maka blok kode dalam if akan dieksekusi. 

Selain operator <=, maka berikut ini adalah beberapa operator 
yang sering digunakan: 

Operator Arti  
==  Sama dengan 
!= Tidak sama dengan 
< Lebih kecil 
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> Lebih besar 
<=  Lebih kecil atau sama dengan 
>=  Lebih besar atau sama dengan 

 
Yap, begitulah cara kerja IF dan beberapa operator yang bisa 

digunakan untuk memeriksa kondisi dalam IF. Simpel sekali bukan? J 

 

2.1.2 Perintah IF - ELSE 
Pada dasarnya IF-ELSE merupakan pengembangan dari IF. ELSE 

berarti kondisi yang tidak sesuai dengan kondisi dalam IF. Dengan 
kata lain, ELSE artinya òjika tidakó. Coba perhatikan kedua pernyataan 
berikut: 

1 
2 

3 

4 
5 

6 

7 
8 

9 
10  

11  

12  

Main; 
jika (sekarang == jam 10){ 
    Makan; 
}  
 

 

Jika (sekarang == jam 10){  
    Makan;  

} jika tidak {  
    Main;  

}  

 
Pada baris 1 sampai 5, maka Main  akan terus dieksekusi. Jika 

sekarang sama dengan jam 10, maka yang dilakukan adalah Main 
sambil Makan. Jadi kedua kegiatan atau statemen akan dieksekusi. 

Berbeda dengan baris 8 sampai 12, jika jam 10 Makan, jika tidak 
jam 10, Main . Begitulah logika IF-ELSE. 

Berikut ini adalah Sketch 2.2 yang merupakan hasil modifikasi dari 
Sketch 2.1 dengan tambahan ELSE dan pemindahan proses 
pengurangan: 

Sketch 2.2 Perubahan IF-ELSE 

1 

2 

// Free Ebook  Arduino  

// www.elangsakt i.com   

http://www.elangsakti.com/
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3 

4 
5 

6 
7 

8 

9 
10  

11  

12  
13  

14  
15  

16  

17  
18  

19  
20  

21  

22  
23  

24  
25  

26  

27  
28  

29  

30  
31  

32  
33  

34  

35  

// coder elangsakti  

 
// Pin 8 untuk LED  

const int  pinLED = 8;  
 

void  setup() {  

    // pin LED sebagai output  
    pinMode(pinLED, OUTPUT);  

}  

 
// awal time delay 1000 | 1 detik  

int  timeDelay = 1000;  
 

void  loop() {  

   
    /* Jika timeDelay bernilai leb ih kecil sama dengan 0  

       maka LED akan diam selama 3 detik  
       lalu  nilai timeDelay direset ke 1000  

     */  

    if (timeDelay <= 100){  
      delay(3000);  

      timeDelay = 1000;  
    } else {  

      // nilai timeDelay dikurangi 100 jika time delay > 100  

      timeDelay = timeDelay -  100;  
    }  

     

    //Nyalakan dan matikan LED selama timeDelay  
    digitalWrite(pinLED, HIGH);  

    delay(timeDelay);  
    digitalWrite(pinLED, LOW);  

    delay(timeDelay);  

}  

 
Pada Sketch 2.2, jika timeDelay bernilai lebih kecil sama dengan 

100, maka akan LED akan diam selama 3 detik lalu nilai timeDelay akan 
direset ke 1000, jika tidak maka akan dilakukan pengurangan terhadap 
timeDelay sebanyak 100. Perhatikan, peroses reset dan pengurangan 
tidak pernah dilakukan bersama-sama. Silakan dicoba dan cek hasilnya! 
J 

Setelah membahas tentang IF dan IF-ELSE, kita akan mebahas 
tentang While. While merupakan salah satu model perulangan dengan 
karakteristik tertentu. Untuk lebih jelasnya, silakan lanjut ke 
pembahasan selanjutnya. 
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2.2 Perulangan dengan WHILE 
Perintah WHILE  merupakan perintah untuk melakukan 

perulangan berdasarkan suatu kondisi, jadi banyaknya perulangan 
tidak bisa ditentukan dengan pasti. Dalam WHILE  seakan ada 
pengecekan kondisi seperti perintah IF untuk melakukan perulangan. 
Bentuk umum dari perintah WHILE  yaitu : 

1 

2 
3 

4 

while( kondisi ){ 
    // eksekusi code 
}  

 
Jika kondisi sesuai, maka perintah atau source code yang ada dalam 

kurung kurawal ò{}ó tersebut akan dieksekusi. Untuk lebih memahami 
tentang perintah WHILE, mari kita modifikasi Sketch 2.2 dengan 
penambahan WHILE dan beberapa perubahan lainnya. 

Sketch 2.3 Perulangan While 

1 
2 

3 
4 

5 

6 
7 

8 

9 
10  

11  
12  

13  

14  
15  

16  
17  

18  

19  
20  

21  
22  

23  

24  
25  

26  

27  

// Free Ebook  Arduino  
// www.elangsakti.com   

// coder elangsakti  
 

// Pin 8 untuk LED  

const int  pinLED = 8;  
 

void  setup() {  

    // pin LED sebagai output  
    pinMode(pinLED, OUTPUT);  

}  
 

// awal ti me delay 1000 | 1 detik  

int  timeDelay = 1000;  
 

void  loop() {  
   

  // selama nilai timeDelay > 0  

  // eksekusi blok program ini  
  while (timeDelay > 0){  

    // LED hidup mati dengan durasi 500 milisekon  
    digitalWrite(pinLED, HIGH);  

    delay(500);  

    dig italWrite(pinLED, LOW);  
    delay(500);  

     

    // kurangi timeDelay dengan 100  

http://www.elangsakti.com/
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28  

29  
30  

31  
32  

33  

34  
35  

36  

37  
38  

39  
40  

41  

42  
43  

44  
45  

46  

47  

    timeDelay = timeDelay -  100;  

  }  
   

  // setelah timeDelay dikurangi terus -menerus  
  // maka pada akhirnya akan bernilai minus atau < 0  

  // maka while di atas akan berhen ti  

   
  // selama nilai timeDelay < 1000  

  // eksekusi blok program ini  

  while (timeDelay < 1000){  
    // LED hidup mati dengan durasi 100 milisekon  

    digitalWrite(pinLED, HIGH);  
    delay(100);  

    digitalWrite(pinLED, LOW);  

    delay(100);  
     

    // tambahkan timeDelay dengan 100  
    timeDelay = timeDelay + 100;  

  }  

}  

 
Program pada Sketch 2.3 akan mengedipkan LED dengan durasi 

yang berbeda. Awalnya LED akan berkedip dengan durasi ½ detik 
sebanyak 10 kali, selanjutnya LED akan berkedip lebih cepat dengan 
durasi 1/10 detik sebanyak 10 kali. 

 

2.3 Kondisi True dan False 
Dalam bahasa pemrograman, kita nantinya akan mempelajari 

tentang perintah-perintah yang berkaitan dengan kondisi (logika) True 
dan False. Perintah-perintah yang berkaitan dengan logika yang umum 
digunakan misalnya IF dan IF-ELSE, dan WHILE yang sudah kita 
pelajari sebelumnya. 

Secara teori, True berarti 1 dan False berarti 0. Dalam 
pemrograman yang ini, kondisi False memang selalu 0, tapi True tidak 
selalu 1. Kondisi True adalah selain 0, ingat selain nol (0) akan 
dianggap True. Coba perhatikan kode di bawah ini: 

 while (1){  

    digitalWrite(pinLED, HIGH);  
    delay(100);  

    digitalWrite(pinLED, LOW);  
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    delay(100);  

}  

 
Program di atas akan dijalankan selamanya (looping forever) selama 

Arduino belum direset atau listrik tidak diputus. Kenapa? Sebab 1 
berarti True. Secara harfiah, baris while(1) dapat diartikan òselama 
bernilai benar, maka eksekusi kode inió. 

Ingat, penulisan operator logika òsama denganó tidak hanya 
menggunakan satu tanda sama dengan ò=ó, tapi menggunakan dua 
sama dengan ò==ó. Jika hanya menggunakan ò=ó, maka pertanyaan 
tersebut bukan untuk logika, tapi untuk operator penetapan isi variabel 
(assignment). Penulisan yang benar adalah: 

 while( timeDelay == 1000 ){  

   //  
}  

 

if( ti meDelay == 0){  
    //  

}  

 
Bukannya, 

 while( timeDelay = 1000 ){    // penulisan yang SALAH!  

    //  
}  

 

if( timeDelay = 0 ){   // penulisan yang SALAH!  
    //  

}  

 

2.4 Kombinasi True dan False 
Terkadang kondisi True atau False bisa terdiri dari beberapa 

kondisi. Misal, kita ingin menentukan bilangan timeDelay sebagai 
angka positif tidak lebih dari 10. Maka kita tidak bisa hanya 
menggunakan satu kondisi. Kita harus menggunakan 2 kondisi, yaitu 
timeDelay harus lebih besar dari 0 DAN timeDelay lebih kecil dari 10. 
Dalam logika, kita bisa menuliskannya dengan cara : 
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 if( (timeDelay > 0) && (timeDelay < 10) ){  

    //  
}  

 
Perhatikan disana ada tanda && yang berarti AND. Penambahan 

tanda kurung untuk memperjelas bahwa ada dua kondisi yang berbeda 
dan dihubungkan oleh operator &&. Silakan diingat kembali bahwa 
operator logika AND akan menghasilkan nilai True jika semua kondisi 
bernilai True. Selain operator AND, ada juga operator OR dan NOT. 
Perhatikan tabel berikut: 

Operator  Contoh Arti  
&& (A < 10) && (B >10) Logika AND akan menghasilkan 

True apabila kondisi A dan B 
sesuai (True), jika tidak, maka 
False 

||  (A < 10) && (B >10) Logika OR akan menghasilkan 
True apabila salah satu dari A, B, 
atau semuanya sesuai (True), tapi 
jika keduanya False, maka akan 
bernilai False 

! ! (A < 10) Logika NOT akan menghasilkan 
True jika kondisi tidak sesuai 
(False), sebab NOT adalah 
kondisi sebaliknya. 

 
Jika Anda masih bingung dengan NOT, maka perhatikan kode 

berikut ini: 

 int status = HIGH;  

 

int led = !status;    // artinya, led TIDAK  high (LOW)  

 
Jika status = HIGH atau True, maka !status = LOW (tidak HIGH) 

atau False (tidak True). Penggunaan juga sering digunakan, jadi 
tolong diingat-ingat. J 
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2.5 Perulangan dengan FOR 
Berbeda dengan WHILE, dengan FOR kita bisa menentukan 

jumlah perulangan dengan pasti. Pada Sketch 2.3, masing-masing 
WHILE akan melakukan perulangan sebanyak 10 kali dengan cara 
mengurangi angka 1000 dengan 100 secara bertahap. Jika 
menggunakan FOR, kita bisa melakukan perulangan tersebut lebih 
sederhana. Format dasar dari FOR adalah : 

   for (statemen; kondisi; statemen){  

 
Statemen yang pertama berisi tentang kondisi awal, biasanya 

inisialisasi suatu variabel atau data (misal, a=0). Sedangkan statemen 
yang terakhir adalah perubahan yang akan terjadi pada variabel pada 
statemen awal (misal a=a+1). Sedangkan kondisi merupakan kondisi 
dimana perulangan akan terjadi, ketika kondisi sudah tidak sesuai, 
maka perulangan akan berhenti. untuk lebih jelasnya tentang FOR, 
berikut contoh sederhananya: 

Sketch 2.4 Perulangan FOR 
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// Free Ebook  Arduino  

// www.elangsakti.com   
// coder elangsakti  

 

// Pin 8 untuk LED  
const int  pinLED = 8;  

 
void  setup( ) {  

    // pin LED sebagai output  

    pinMode(pinLED, OUTPUT);  
}  

 

// awal time delay 1000 | 1 detik  
int  timeDelay = 3000;  

 
void  loop() {  

  // perulangan sebanyak 10 kali dari 1 hingga 10  

  for ( int  i=1; i<=10; i++){  
    // LED hidup mati dengan durasi 500 m ilisekon  

    digitalWrite(pinLED, HIGH);  
    delay(500);  

    digitalWrite(pinLED, LOW);  

    delay(500);  
  }  

  // diam selama 3 detik  

http://www.elangsakti.com/
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27  

  delay(timeDelay);  

}  

 
Ketika program tersebut diupload, maka LED akan berkedip 

dengan durasi ½ detik sebanyak 10 kali, kemudian LED akan diam 
(mati) selama 3 detik (perhatikan, nilai timeDelay diganti 3000), dan 
melanjutkan berkedip lagi. Perhatikan pada baris 14: 

18    for ( int  i=1; i<=10; i++){  

 
Pada baris 18 menunjukkan FOR dengan kondisi nilai awal i=1, i 

akan terus-menerus ditambah dengan 1 (i++) selama perulangan 
selama i <= 10. Sederhananya, nilai i akan berubah dari 1, 2, 3, 4, é 
hingga 10. 

Bagian penting yang perlu dipahami adalah i++, i++ sama dengan 

i = i + 1; 

Selain i++, ada juga ++i, i--, dan --i. Penulisan i-- sama dengan 
i++, hanya saja i-- berarti i=i -1, atau i akan berkurang 1 terus-menerus 
selama perulangan. 

Penempatan ++ di depan atau di belakang i berarri bahwa : jika 
++ nya ada di belang, maka proses penambahannya dilakukan setelah 
blok kode dalam for dijalankan. Tapi jika ++ nya ada di depan, maka 
proses penambahan akan dilakukan sebelum proses dijalankan. Begini 
contohnya: 

1 

2 
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5 
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8 
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10  
11  

12  

// Free Ebook  Arduino  

// www.elangsakti.com   
// coder elangsakti  

 

in t i = 1;  
int j = 3 * (i++);  // j = 3 karena 3 * 1  

 

// i = 2  
 

int j = 3 * (++i);  // j = 9 karena 3 * 3  
 

// i sudah ditambah dengan 1 lagi (++i) sebelum baris 6 dieksekusi  

 

http://www.elangsakti.com/


28 

Perhatikan, pada baris ke-6, j bernilai 3 karena 3 dikali dengan 
nilai i = 1. Setelah proses pada baris ke-4, maka nilai i akan berubah 
menjadi 2 karena ada statemen i++ (i = i+1). 

Sedangkan pada baris ke-10, j bernilai 9 (bukan 6) karena i tidak 
bernilai 2 lagi, tapi i bernilai 3 sebab sebelum baris tersebut dieksekusi i 
terlebih dahulu ditambahkan dengan 1 (++1). Jadi penambahan i tidak 
dilakukan setelah eksekusi baris 10 baris tersebut, tapi sebelum 
mengeksekusi baris ke-10. 

Semoga sekilas penjelasan ini bisa memberikan gambaran tentang 
perbedaan FOR dan WHILE. Jika ada penjelasan yang 
membingungkan, silakan ditanyakan di http://www.elangsakti.com. 
Setelah ini kita akan merangkai kombinasi LED lebih dari satu karena 

kita akan mencoba belajar tentang Array. J 

 

2.6 Update Rangkaian LED 

 

Rangkaian 2.1 Array LED dengan 4 resistor 

Silakan update rangkaian Arduino Anda seperti rangkain 2.1. 
Siapkan 4 buah resistor dan 4 buah LED. Siapkan kabel jumper untuk 
menyuplai GDN pada project board. Masing-masing kaki negatif LED 
dihubungkan ke GND dengan resistor. Sedangkan keempat LED 
tersebut dihubungkan berturut-turut dengan pin 8, 9, 10, dan 11 pada 
board Arduino. 

http://www.elangsakti.com/
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Jika Anda tidak memiliki banyak resistor untuk dicoba, maka Anda 
bisa menggukaan 1 resistor saja dengan rangkaian seperti Rangkaian 
2.2, tapi dengan konsekuensi : suplai arus akan dipakai bersama 
sehingga nyala LED akan semakin redup (atau mungkin LED tidak 
akan menyala, tergantung pada LED yang Anda gunakan). 

 

Rangkaian 2.2 Array LED dengan 1 resistor 

Pada rangkaian 2.2, keempat resistor digantukan dengan kabel 
jumper, kemudian pasang 1 resistor untuk menghubungkan kolom 
GND pada project board ke GND pada board Arduino.  

Untuk sekedar percobaan, cara seperti Rangkaian 2.2 bisa Anda 
gunakan. Tapi Anda tidak disarankan mengaplikasikan cara yang 
kedua ketika menggunakan sensor sebab sedikit banyak akan 
mempengaruhi kinerja sensor tersebut. 

Jika sudah dirangkai, silakan upload Sketch 2.5 berikut: 

Sketch 2.5 Animasi LED 

1 
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4 
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6 
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9 
10  

// Free Ebook  Arduino  
// www.elangsakti.com   

// coder elangsakti  

 
// Inisialisasi Pin LED  

const int  pinLED1 = 8;  
const int  pinLED2 = 9;  

const int  pinLED3 = 10;  

const int  pinLED4 = 11;  
 

http://www.elangsakti.com/
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11  

12  
13  

14  
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17  
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55  

56  
57  

void  setup() {  

    // pin LED sebagai output  
    pinMode(pinLED1, OUTPUT);  

    pinMode(pinLED2, OUTPUT);  
    pinMo de(pinLED3, OUTPUT);  

    pinMode(pinLED4, OUTPUT);  

}  
 

void  loop() {  

  // perulangan sebanyak 5 kali  
  // dari i=0 hinga i=4 atau (i < 5)  

  for ( int  i=0; i<5; i++){  
    if (i==1){  

      // jika i=1, hidupkan led 1, led yang lain mati  

      digitalWrite(pinLED 1, HIGH);  
      digitalWrite(pinLED2, LOW);  

      digitalWrite(pinLED3, LOW);  
      digitalWrite(pinLED4, LOW);  

    } else if (i==2){  

      // jika i=2, hidupkan led 1 & 2, led 3 & 4 mati  
      digitalWrite(pinLED1, HIGH);  

      digitalWrite(pinLED2, HIGH);  
      digitalWrite(pinLED3, LOW);  

      digitalWrite(pinLED4, LOW);  

    } else if (i==3){  
      // jika i=3, hidupkan led 1, 2, & 3, led 4 mati  

      digitalWrite(pinLED1, HIGH);  

      digitalWrite(pinLED2, HIGH);  
      digitalWrite(pinLED3, HIGH);  

      dig italWrite(pinLED4, LOW);  
    } else if (i==4){  

      // jika i=4, hidupkan semua led  

      digitalWrite(pinLED1, HIGH);  
      digitalWrite(pinLED2, HIGH);  

      digitalWrite(pinLED3, HIGH);  
      digitalWrite(pinLED4, HIGH);  

    } else {  

      // jika tidak, m atikan semua led  
      digitalWrite(pinLED1, LOW);  

      digitalWrite(pinLED2, LOW);  

      digitalWrite(pinLED3, LOW);  
      digitalWrite(pinLED4, LOW);  

    }  
    // delai selama 5 detik  

    delay(5000);  

  }  
}  

 
Program di atas akan membuat LED menyala bergantian 

sebanyak 5 animasi (perulangan sebanyak 5 kali). Pertama, semua LED 
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akan mati selama 5 detik. Kedua, LED 1 akan menyala. Ketiga, LED 1 
dan 2 akan menyala. Keempat, LED 1, 2, dan 3 akan menyala. Kelima, 
semua LED akan menyala. 

Animasi tersebut ditentukan berdasarkan nilai i, nilai i diperiksa 
dengan perintah IF. Jika nilai i=0, maka semua LED mati, jika i=1 
maka satu LED nyala, dan seterusnya. 

Selain menggunakan IF, ada cara lain yang lebih simpel untuk 
membuat animasi LED seperti program pada Sketch 2.5. perhatikan 
Sketch 2.6: 

Sketch 2.6 Animasi LED Alternatif 
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// Free Ebook  Arduino  

// www.elang sakti.com   
// coder elangsakti  

 
// Inisialisasi Pin LED  

const int  pinLED1 = 8;  

const int  pinLED2 = 9;  
const int  pinLED3 = 10;  

const int  pinLED4 = 11;  

 
void  setup() {  

  // pin LED sebagai output  
  pinMode(pinLED1, OUTPUT);  

  pinMode(pinLED2, OUTPUT);  

  pin Mode(pinLED3, OUTPUT);  
  pinMode(pinLED4, OUTPUT);  

}  
 

void  loop() {  

  digitalWrite(pinLED1, LOW);  
  digitalWrite(pinLED2, LOW);  

  digitalWrite(pinLED3, LOW);  

  digitalWrite(pinLED4, LOW);  
  delay(1000);  

  digitalWrite(pinLED1, HIGH);  
  delay(1000);  

  digit alWrite(pinLED2, HIGH);  

  delay(1000);  
  digitalWrite(pinLED3, HIGH);  

  delay(1000);  
  digitalWrite(pinLED4, HIGH);  

  delay(1000);  

}  

 

http://www.elangsakti.com/
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Dengan memanfaatkan delay, program pada Sketch 2.6 lebih 
simple daripada Sketch 2.5. Kira-kira, apakah ada cara yang lebih 
simpel lagi? Ada! Kita bisa menggunakan Array. Apa itu Array? 

 

2.7 Pengenalan Array 
Array merupakan variabel yang bisa menampung banyak data, 

masing-masing data bisa diambil dengan alamat indeks (posisi) data 
dalam Array tersebut. Alamat indeks pada array standarnya adalah 
angka integer yang diawali dari angka 0. Jadi, jika kita punya data 5 
dalam variabel Array, maka data pertama pada alamat indeks ke-0, data 
ke-2 pada alamat indeks ke-1, dan data ke-5 pada alamat indeks ke-4. 

Untuk lebih memahami tentang Array, program pada Sketch 2.7 
merupakan versi lebih simpel daripada Sketch 2.6 dengan 
memanfaatkan perulangan FOR dan Array. 

Sketch 2.7 Animasi LED dengan Array 
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// Free Ebook  Arduino  
// www.elangsakti.com   

// coder elangsakti  

 
// Inisialisasi Jumlah LED  

const int  numLED = 4;  

// LED 1,2,3,&4 jadi 1 varibel  
// dengaan alamat index 0,1,2,3  

const int  pinLED[nu mLED] = {8,9,10,11};  
 

void  setup() {  

  // Inisialisasi semua pin LED sebagai OUTPUT  
  for ( int  i=0; i<4; i++){  

    pinMode(pinLED[i], OUTPUT);  
  }  

}  

 
void  loop() {  

  // Matikan semua LED  

  for ( int  i=0; i<4; i++){  
    digitalWrite(pinLED[i], LOW);  

  }  
  dela y(1000);  

   

  // Hidupkan semua LED bertahap dg jeda 1 detik  
  for ( int  i=0; i<4; i++){  

http://www.elangsakti.com/
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    digitalWrite(pinLED[i], HIGH);  

    delay(1000);  
  }  

}  

 
Jika dibandingkan dengan Sketch 2.6 yang tanpa baris keterangan 

komentar, maka Sketch 2.7 jauh lebih pendek dan lebih simpel. 

Pada Sketch 2.7, keempat LED dimuat dalam satu variabel yaitu 
variabel Array pinLED. Masing-masing LED bisa diakses berdasarkan 
alamat indeks. Perhatikan pada baris 9. 

9 const in t pinLED[numLED] = {8,9,10,11};  

 
Secara otomatis, alamat indeks untuk masing-masing LED 

tergantung pada urutan pin tersebut. Pin 8 ada pada alamat indeks ke-
0, pin 9 ada pada indeks ke 1, pin 10 ada di indeks ke 2, dan pin 11 ada 
pada indeks ke 3. Sehingga untuk mengakses pin 8, kita bisa 
menambahkan kurung siku dan alamat indeks ke-0, seperti berikut: 

Pin8 = pinLED[0]  

Karena indeks tertinggi adalah angka 3, maka di setiap perulangan 
LED tidak boleh lebih dari 3 atau < 4, perhatikan perintah FOR 
berikut: 

13  for ( int  i=0; i<4; i++){  

 
Yap, semoga penjelasan Array di atas mudah dipahami. Jika ada 

yang membingungkan, silakan tanya-tanya di website, dengan senang 
hati penulis akan menjawab. Baik, selanjutnya kita akan lebih 
mengembangkan Sketch 2.7 agar sedikit lebih kompleks dan 
animasinya lebih menarik. Penulis memberikan Sketch 2.8 dan Sketch 
2.9 untuk dianalisa dan dipelajari: 

Sketch 2.8 Bonus Animasi LED 1 
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// Free Ebook  Arduino  
// www.elangsakti.com   

// coder elangsakti  
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// Inisialisasi Jumlah LED  

const int  numLED = 4;  
// LED 1,2,3,&4 jadi 1 varibel  

// dengaan alamat index 0,1,2,3  
const int  pinLED[numLED] = {8,9,10,11};  

 

void  setup() {  
  // Inisialisasi semua pin LED seb agai OUTPUT  

  for ( int  i=0; i<4; i++){  

    pinMode(pinLED[i], OUTPUT);  
  }  

}  
 

void  loop() {  

  // Hidupkan semua LED bertahap dg jeda 1 detik  
  for ( int  i=0; i<4; i++){  

    digitalWrite(pinLED[i], HIGH);  
    delay(500);  

  }  

   
  // Matika semua LED bertahap dg jeda 1 detik  

  for ( int  i=0; i<4; i++){  
    digitalWrite(pinLED[i], LOW);  

    delay(500);  

  }  
}  

 

Sketch 2.9 Bonus Animasi LED 2 
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// Free Ebo ok  Arduino  

// www.elangsakti.com   

// coder elangsakti  
 

// Inisialisasi Jumlah LED  
const int  numLED = 4;  

// LED 1,2,3,&4 jadi 1 varibel  

// dengaan alamat index 0,1,2,3  
const int  pinLED[numLED] = {8,9,10,11};  

 
void  set up() {  

  // Inisialisasi semua pin LED sebagai OUTPUT  

  for ( int  i=0; i<4; i++){  
    pinMode(pinLED[i], OUTPUT);  

  }  
}  

 

void  loop() {  
  // hidupkan led indeks 0 hingga 2 satu -persatu  

http://www.elangsakti.com/
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  for ( int  i=0; i<3; i++){  

    digitalWrite(pinLED[i], HIGH);  
    delay(200 );  

    digitalWrite(pinLED[i], LOW);  
  }  

  // hidupkan led indeks 3 hingga 1 satu -persatu  

  for ( int  i=3; i>0; i -- ){  
    digitalWrite(pinLED[i], HIGH);  

    delay(200);  

    digitalWrite(pinLED[i], LOW);  
  }  

}  
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Apakah Kelemahan kita?  

Kelemah an kita ialah, kita kurang 

percaya diri kita sebagai bangsa, 

sehingga kita menjadi bangsa penjiplak 

luar negeri, kurang mempercayai satu 

sama lain, padahal kita ini asalnya 

adalah Rakyat Gotong Royong!  

 (Ir. Soekarno)  
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Bagian 3 

Input 
 

Sebelumnya kita telah belajar tentang bagaimana mengendalikan 
LED. Untuk mengendalikan LED kita menjadi pin pada Arduino 
sebagai OUTPUT. Pada bagian ini kita akan membahas tentang 
bagaimana menjadikan pin Arduino sebagai INPUT dan sebagai 
aplikasinya, kita akan menggunakan komponen pushbotton dan 
potensiometer sebagai input untuk mengendalikan LED. Bagian ini akan 
menjadi dasar agar Anda memahami bagaimana membuat Arduino bisa 
membaca sensor untuk mendeteksi kondisi lingkungan sekitar. 

 

3.1 Pushbutton 
Pertama kita akan bermain dengan tombol pushbutton (tactile) atau 

tombol push on. Ketika tombol ini ditekan, maka jalur akan tertutup 
(ON), ketika dilepas jalur akan kembali terbuka (OFF). Tombol banyak 
digunakan untuk peralatan seperti remote, keypad, keyboard, atau 
tombol untuk pengaturan TV, ld atau sejenisnya. 

 

Gambar 3.1 Pushbutton dan simbolnya 

Gambar 3.1 merupakan bentuk fisik pushbutton dan salah satu 
simbol pushbotton jenis NO (Normally Open) dalam rangkaian elektronik. 
Berdasarkan simbol tersebut, Normally Open berarti kondisi normal 
(sebelum ditekan), maka terminal dalam kondisi tidak tersambung 
(open, terbuka). Tapi ketika ditekan, maka masing-masing terminal 
akan terhubung. 
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Selain jenis NO, ada juga pushbutton jenis NC (Normally Close), 
artinya ketika kondisi normal (sebelum ditekan), kaki terminal dalam 
keadaan terturup / tersambung (Close), tapi ketika ditekan, kaki 
terminalnya terbuka (tidak tersambung). Dalam ebook ini, kita akan 
menggunakan jenis pushbutton NO. 

 

3.1.1 Satu Tombol dan Satu LED 
Percobaan kali ini adalah untuk mengendalikan hidup/matinya-

nya LED dengan tombol pushbutton. Jika tombol ditekan, LED akan 
menyala, jika dilepas, LED kembali padam. 

Untuk melakukan percobaan ini, siapkan sebuah pushbutton, sebuah 
LED, dan sebuah resistor. Siapkan juga beberapa kabel jumper untuk 
merangkai komponen-komponen tersebut. 

 

3.1.1.1 Rangkaian 

Silakan buat rangkaian seperti Rangkaian 3.1 berikut: 

 

Rangkaian 3.1 Pushbutton dan LED 

1. Siapkan LED dan pushbutton pada project board. Karena 
karena pushbutton memiliki 4 buah kaki yang masing-masing 
terpisah, maka silakan tancapkan pushbutton di tengah-tengah 
lajur project board sehingga kaki-kainya tidak tersambung. 
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2. Salah satu kaki pushbutton dihubungkan ke GDN di project 
board, sedangkan kaki pasangannya disambungkan ke pin 2 
pada board Arduino. Bagaimana cara mengetahui pasangan 
kaki-kaki pada pushbutton? Anda bisa mengeceknya dengan 
AVO meter. 
V Setting AVO meter untuk menghitung resistansi, 

kemudian cek masing-masing pin pushbutton dengan 
probe. Jika tombol ditekan jarum AVO meter bergerak 
menyimpang, berarti kaki-kaki tersebut sepasang. 

3. Untuk LED, sambungkan kaki negatif (pin yang lebih pendek) 
ke GND dengan resistor 

4. Kaki positif (kaki yang lebih panjang) disambungkan ke pin 8 
pada board Arduino dengan jumper. 

 

3.1.1.2 Program 

Mari kita coba dengan program berikut: 

Sketch 3.1 Mengendalikan LED dengan pushbutton 

1 

2 

3 
4 

5 
6 

7 

8 
9 

10  
11  

12  

13  
14  

15  

16  
17  

18  
19  

20  

21  
22  

23  

//  Free Ebook  Arduino  

// www.elangsakti.com   

// coder elangsakti  
 

// pin 2 sebagai input dan pin 8 sebagai output  
const int  pinButton = 2;  

const int  pinLED = 8;  

 
void  setup() {  

  pinMode(pinButton, INPUT);  
  pinMode(pi nLED, OUTPUT);  

   

  // aktifkan pull -up resistor  
  digitalWrite(pinButton, HIGH);  

}  

 
void  loop() {  

  if (digitalRead(pinButton) == LOW){  
    digitalWrite(pinLED, HIGH);  

  } else {  

    digitalWrite(pinLED, LOW);  
  }  

}  

 

http://www.elangsakti.com/
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Pertama kali dijalankan, maka awalnya LED akan padam. ketika 
kita menekan tombol pushbutton, maka LED akan menyala. LED akan 
kembali padam ketika tekanan tombol dilepas. Pada Sketch 3.1 di atas 
ada beberapa baris kode baru: 

10  
11  

12  

13  
14  

  pinMode(pinButton, INPUT);  
  pinMode(pinLED, OUTPUT);  

   

  // aktifkan pull -up resistor  
  digitalWrite(pinButton, HIGH);  

 
Baris 6 berfungsi untuk mengeset pinButton sebagai INPUT. Jika 

sebuah pin diset sebagai INPUT, maka mikrokontroller akan 
mengambil data dari pin tersebut. Jika sebuah pin diset sebagai 
OUTPUT, maka mikrokontroller akan menuliskan data pada pin 
tersebut. dalam hal ini, mikrokontroller akan mengambil data yang 
dari pushbutton. 

Perhatikan baris ke-14. Nilai pinButton awalnya diset HIGH. 
Kenapa diset HIGH? Kenapa bisa diset nilai pinnya menjadi HIGH, 
padahal pin tersebut tidak terhubung dengan +5V? 

Begini, pemilihan settingan awal dengan HIGH atau LOW untuk 
pinButton tergantung pada rangkaian yang akan digunakan. Rangkaian 
3.1 menghubungkan pinButton (pin 8) ke GND, artinya, ketika 
pushbutton ditekan maka pinButton (pin 8) akan menjadi 0 (LOW). 
Padahal defaultnya, setiap pin bernilai LOW. Jika pin awalnya bernilai 
LOW, kemudian ditekan tetap bernilai LOW, lalu apa gunanya 
pushbutton? J 

Padahal, fungsi utama dari saklar (dalam hal ini adalah pushbutton) 
adalah mengubah nilai yang awalnya LOW menjadi HIGH, atau 
sebaliknya. Nah, karena ketika pushbutton ditekan akan bernilai LOW 
(ke GND), maka awalnya harus kita set menjadi HIGH. Sehingga 
logika untuk pushbutton tersebut adalah: ketika tidak ditekan HIGH, 
ketika ditekan LOW. 

Kondisi tersebut yang akan digunaka untuk mendeteksi apakah 
pushbutton tersebut ditekan atau tidak. Silakan perhatikan baris ke-18.  

18    if (digitalRead(pinButton) == LOW){  
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19  

20  
21  

22  

    digitalWrite(pinLED, HIGH);  

  } else {  
    digitalWrite(pinLED, LOW);  

  }  

 
Pada baris 18, fungsi digitalRead() untuk membaca logika pada 

pinButton. Jika pinButton ditekan (LOW), maka hidupkan LED dengan 
perintah digitalWrite(pinLED,HIGH). Ketika pinButton bernilai HIGH, 
matikan LED. Sederhana bukan? J 

Untuk pertanyaan yang kedua, kenapa pin INPUT bisa diset 
HIGH? 

Ketika kita menjadi pin INPUT sebagai HIGH, maka secara 
internal Arduino akan menghubungkan pin tersebut pada resistor pull-
up bernilai 20k ohm. Apa itu pull-up resistor? Jika ada pull-up, apakah 
juga ada pull-down resistor? 

 

Gambar 3.2 Skema pull-up resistor 

Begini, dalam elektronika digital, jika sebuah pin diset sebagai 
INPUT, kemudian pin tersebut belum tersambung ke VCC atau GND, 
maka logika pada pin tersebut masih mengambang (floating). Oleh 
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sebab itu, pin tersebut harus ditentukan apakah akan diberi resistor 
pull-up (sehingga bernilai HIGH) atau diberi pull-down (sehingga 
bernilai LOW). 

Jika pin tersebut diset HIGH, dalam internal mikrokontroller pin 
tersebut akan disambungkan ke VCC dengan pengaman sebuah 
resistor yang diistilahkan sebagai resistor pull-up. Begitu juga jika pin 
tersebut diset LOW, maka pin tersebut akan dihubungkan ke GND 
dengan pengaman resistor kemudian diistilahkan dengan resistor pull-
down. Gambar 3.2 adalah rangkaian dasar pull-up resistor untuk 
rangkain di atas tanpa LED. 

Semoga penjelasan tentang pull-up resistor bisa dipahami. Jika ada 
yang kurang jelas, mari kita diskusikan di website. J 

 

3.1.2 Mengontrol Tingkat Kecerahan LED 

Sebelumnya kita sudah membahas tentang cara menghidupkan 
dan mematikan LED dengan sebuah pushbutton. Selanjutnya, kita akan 
menggunakan dua buah pushbutton dengan ketentuan : pushbutton yang 
pertama untuk menaikkan kecerahan LED hingga paling terang, 
sedangkan pushbutton yang kedua untuk menurunkan kecerahan LED 
hingga LED padam. 

Fungsi kedua pushbutton ini mirip dengan volume-up dan volume-
down. Yang satu untuk meningkatkan volume (kecerahan), sedangkan 
satunya lagi untuk menurunkan volume (kecerahan). Yak, setidaknya 
Anda paham apa yang saya maksudkan. J 

Setidaknya ada dua cara untuk menaikkan atau menurunkan 
tingkat kecerahan LED: 

1. Mengubah arus yang masuk ke LED, cara ini bisa 
diaplikasikan dengan mengubah nilai resistor 

2. Menghidup-matikan LED dengan cepat atau lambat. Begini, 
ketika kita menghidup-matikan LED dengan cepat, maka mata 
manusia tidak bisa mengetahuinya. Yang ditangkap oleh mata 
adalah terang atau redupnya saja. Jika kita menghidup-
matikan led dengan cepat, maka LED tersebut akan terlihat 
terang, tapi kalau kita menghidup matikan LED dengan lebih 
lambat, maka LED akan terlihat lebih redup. 
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Dalam elektronika digital, konsep yang kedua dikenal dengan 
istilah PWM (Pulse Width Modulation). Apa itu PWM? 

Sebagian kaki / pin Arduino support PWM, kaki yang support 
PWM ditandai dengan adanya tanda tilde (~) di depan angka pinnya, 
seperti 3, 5, 6, dan seterusnya. Frekuensi yang digunakan dalam 
Arduino untuk PWM adalah 500Hz (500 siklus dalam 1 detik). Jadi, 
Arduino bisa menghidup-matikan LED sebanyak 500 kali dalam 1 
detik. 

Untuk menggunakan PWM, kita bisa menggunakan fungsi 
analogWrite(). Nilai yang bisa dimasukkan pada fungsi tersebut yaitu 
antara 0 hingga 255. Nilai 0 berarti pulsa yang diberikan untuk setiap 
siklus selalu 0 volt, sedangkan nilai 255 berarti pulsa yang diberikan 
selalu bernilai 5 volt. 

 

Gambar 3.3 Siklus pulsa PWM 

Jika kita memberikan nilai 127 (kita anggap setengah dari 0 
hingga 255, atau 50% dari 255), maka setengah siklus akan bernilai 5 
volt, dan setengah siklus lagi akan bernilai 0 volt. Sedangkan jika jika 
memberikan 25% dari 255 (1/4 * 255 atau 64), maka 1/4 siklus akan 
bernilai 5 volt, dan 3/4 sisanya akan bernilai 0 volt, dan ini akan terjadi 
500 kali dalam 1 detik. Untuk visualisasi siklus PWM, bisa Anda lihat 
Gambar 3.3.  
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3.1.2.1 Rangkaian 

 

Rangkaian 3.2 Pengaturan Intensitas Cahaya LED 

Buatlah rangkaian seperti gambar Rangkaian 3.2. Rencananya, 
pushbutton yang atas untuk menyalakan dan meningkatkan kecerahan 
LED, sedangkan pushbutton yang bawah untuk menurunkan tingkat 
kecerahan LED dan memadamkannya: 

1. Seperti biasa, siapkan sebuah LED dan resistornya. 
Sambungkan kaki positif LED ke pin 8 Arduino. 

2. Kemudian kaki negatif LED disambungkan ke resistor menuju 
GND. 

3. Siapkan dua buah pushbutton. Pushbutton yang pertama (atas) 
disambunkan ke GND dan ke pin 2 pada board Arduino. 

4. Lalu pushbutton yang kedua (bawah) disambungkan ke GND 
dan pin 3 pada board Arduino. 

 

3.1.2.2 Program 

Sketch 3.2 Mengatur intensitas cahaya LED 

1 
2 

3 
4 

5 

6 
7 

8 

// Free Ebook  Arduino  
// www.elangsakti.com   

// coder elangsakti  
 

// pin 2 & 3  sebagai input digital  

const int  pinBt1 = 2;  
const int  pinBt2 = 3;  

 

http://www.elangsakti.com/
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9 

10  
11  

12  
13  

14  

15  
16  

17  

18  
19  

20  
21  

22  

23  
24  

25  
26  

27  

28  
29  

30  
31  

32  

33  
34  

35  

36  
37  

38  
39  

40  

41  
42  

// Ingat, pin 9 support PWM  

const int  pinLED = 9;  
 

void  setup() {  
  pinMode(pinBt1, INPUT);  

  pinMode(pinBt2, INPUT);  

  pinMode(pinLED, OUTPUT);  
   

  digitalWrite(pinBt1, HIGH);  

  digitalW rite(pinBt2, HIGH);  
}  

 
int  brightness = 0;  

void  loop() {  

  if (digitalRead(pinBt1) == LOW){  
    // jika pushbutton ditekan  

    // tambahkan nilai brightness  
    brightness++;  

  } else if (digitalRead(pinBt2) == LOW){  

    // jika pushbutton2 ditekan  
    // kur angi nilai brightness  

    brightness -- ;  
  }  

   

  // brightness dibatasi antara 0 -  255  
  // jika di bawah 0, maka ganti dengan 0  

  // jika di atas 255, maka ganti dengan 255  

  brightness = constrain(brightness, 0, 255);  
   

  // pinLED diberi nilai antara 0  -  255  
  analogWrite(pinLED, brightness);  

  // delay agar perubahannya bertahap  

  delay(20);  
}  

 
Ada 3 bagian pada Sketch 3.2 yang perlu dijelaskan lebih detail, 

yaitu pada baris 36, 39, dan 41. 

33  
34  

35  

36  

  // brightness dibatasi antara 0 -  255  
  // jika  di bawah 0, maka ganti dengan 0  

  // jika di atas 255, maka ganti dengan 255  

  brightness = constrain(brightness, 0, 255);  

 
Pada baris 36, kita menemukan satu fungsi baru, yaitu constrain(). 

Fungsi constrain() digunakan untuk menjaga agar nilai tetap pada range 
yang ditentukan. Pada kasus ini, range yang ditentukan adalah antara 0 
ð 255. Misal nilai brightness lebih kecil dari 0, maka akan dirubah 
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menjadi 0, tapi jika nilai brightness lebih besar dari 255, maka akan 
dirubah menjadi 255. 

Untuk lebih memahami tentang fungsi constrain(), silakan 
perhatikan isi dari fungsi constrain() di bawah ini: 

 int  constrain( int  value, int  min, int  max){  

    if (value > max){  
        value = max;  

    }  
    if (value < min){  

        value = min;  

    }  
    return  value;  

}  

 

 
Tipe dari fungsi tersebut adalah int (integer), artinya fungsi 

tersebut akan mengembalikan nilai integer ketika dieksekusi 
disesuaikan dengan nilai value (return  value). 

Jika diperhatikan fungsi loop() dan fungsi setup() bukanlah int , tapi 
void. Tipe fungsi void berbeda dengan tipe int , fungsi void tidak 
mengembalikan nilai apa pun, sehingga jika diperhatikan, tidak ada 
perintah return pada fungsi dengan tipe void. Yap, demikian sekilas 
tentang tipe fungsi integer dan void. 

Selanjutnya, karena nilai brightness selalu antara 0-255, maka 
ketika dituliskan ke pinLED juga akan selalu selang antara 0-255 
(perhatikan baris 39). 

38  
39  

  // pinLED diberi nilai antara 0 -  255  
  analogWrite(pinLED, brightness);  

 
Fungsi analogWrite() digunakan untuk memberikan data PWM 

atau data analog. analogWrite() bisa menuliskan data dengan selang 
antara 0v hingga +5v pada pin INPUT. Berbeda dengan digitalWrite() 
yang hanya bisa menuliskan HIGH atau LOW, atau +5v atau 0v saja. 

40  
41  

  // delay agar perubahannya bertahap  
  delay(20) ;  
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delay(20) berfungsi untuk mengatur durasi perubahan intensitas 
cahaya LED. Jika delay(20) kita hilangkan, maka LED akan langsung 
hidup atau langsung mati ketika tombol ditekan. Jika kecilkan nilainya, 
maka perubahan intensitas akan lebih cepat, dan sebaliknya, jika kita 
besarkan nilainya, maka perubahan intesitas akan lebih lama dengan 
catatan kita harus menahan ketika menekan tombol pushbutton. 

Lalu bagaimana jika kita menekan kedua tombol pushbutton dengan 
bersamaan? Apa yang akan terjadi dengan LED? Silakan cari jawaban 
dan penjelasannya. J 

 

3.2 Potensiomenter 
Setelah kita belajar mengatur intensitas cahaya LED dengan 

pushbutton, kali ini kita akan mengunakan potensiometer. Kelebihan 
menggunakan potensiometer yaitu kita lebih mudah sebab kita hanya 
butuh satu alat untuk membuat LED lebih redup atau lebih terang. 

Kenapa kita harus melalui mikrokontroller? Kan bisa saja kita 
menghubungkan langsung ke LED untuk mengatur arus yang masuk? 
Betul sekali. 

 

Rangkaian 3.3 Mengatur intensitas cahaya LED dengan potensiometer 

Jika kita langsung mengatur LED dengan potensiometer, kita 
harus memiliki potensiometer yang pas untuk LED tersebut. Jika 
hambatan potensiometer tidak sesuai, mungkin LED akan mati 














































































































